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Authority: CADD Manual & Production Criteria Handbook
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FDOT Project Directory Structure

Every discipline has a standard place to put their data

Note on file naming: Don’t create file names 
with special characters in the name, such as 
“~!@#$%^&\,:;”  Keep file names short, and 
avoid using spaces in the names where possible 
(substitute “_” for space).  

Look at those wild directory 
& file names Junior!  No 
wonder MicroStation doesn’t 
work right!  FDOT stuff too!
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SheetInfo and SheetNavigator
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Sheet Info/Sheet Navigator

Foundation program for all subsequent Electronic Delivery 
processes
This software extracts the data from the sheet borders (Sheet 
type, Sheet number, Description, County, FPID number, 
Coordinates, etc).
You must follow CADD standards (symbology must be right for 
sheets)
Should be run from MicroStation on every design file that has 
sheets in it (and checked that the data is being extracted / edited 
properly)
SheetInfo is run “silently” by the Electronic Delivery Indexer and 
FDOT Batch plotting programs (so it is important that the third 
bullet (above) performs correctly
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Sheet Navigator Overview

The old functions of SheetInfo & Navigator have 
been implemented as one tool.  Sheet Navigator.
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Sheet Navigator Overview

The dialog is divided into two tabs.  Sheet 
Edit and Navigator.
The Menu Bar contains four pull down 
menus; File, Renumbering, Settings, and 
Help.
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Sheet Edit Tab
The Sheet Edit tab is very similar to, and performs 
the same function as the previous SheetInfo tool.
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Sheet Edit Tab

Locates all sheets displayed in a .dgn file 
without regard to file location. (i.e. Sheets can 
be in a reference file.)
Text fields on the dialog correspond with 
information fields on the sheet cell.  Data 
entered in the dialog will be placed on the 
sheet in Enter Data Fields.
Relevant Sheet information is tagged to the 
sheet for later retrieval during the Electronic 
Delivery process.   
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Sheet Edit Tab

Allows for marking 
unused sheets as 
“Obsolete”.  A large red 
X will be placed over 
obsolete sheets, and 
these sheets will not be 
indexed or plotted.
Automatically places 
the Electronic Plan 
Note required on 
electronically signed & 
sealed plan sets. 

A “Show Coordinates” 
button displays either 
the physical file’s 
location coordinates, or 
the State Plane 
Coordinates, of the 
sheet boundary.
Selecting a sheet in the 
dialog will highlight the 
sheet border.  Double 
clicking will center the 
sheet in the active view.
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Navigator Tab 

The Navigator creates and reads an XML file to 
display an interactive index of sheets.
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Navigator Tab

The Navigator index displays the Sheet 
number, Sheet Description, DGN Format (V7 
or V8), Filename, Model, and Road Number.  
The Signed check box indicates if the sheet 
contains the Electronic Plan Note.
The index can be sorted by clicking on any of 
the category titles.
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Navigator Tab
Sheets can be filtered by Key Sheet Component 
using the drop down menu.

Displays the total number 
of sheets in the project.
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File Menu

New…Creates an new 
XML index for the 
Navigator tab.  Creating 
a new XML file may 
take several minutes.
Open…Opens an 
existing XML index, 
displaying the contents 
in the Navigator view.
Exit…Closes the tool.



15

Renumbering Menu

Start Renumbering 
Process…Places 
Sheet Navigator into 
Renumbering Mode 
and un-ghosts the other 
selections on the 
Renumbering Menu.
Renumbering Mode is 
denoted by a red box 
around the tab area, 
and the addition of a 
Multi Sheet Edit tab.
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Renumbering Mode

Renumbering Mode allows for automatic mass renumbering 
of a range of sheets.  The user can also add or change any 
information on a sheet, or sheets, that is available on the 
Sheet Edit tab.  For example, the Road No. can be changed 
or added on every sheet in the project without ever leaving 
the current design file.
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Renumbering Mode

Add Sheet 
Placeholders…Used 
to increment sheet 
numbers to make room 
for inserting additional 
sheets.
Remove Sheet 
Placeholders…Autom
atically renumbers 
sheets removing gaps 
in numbers.
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Renumbering Mode

Finish & Apply 
Changes…Exits 
Renumbering Mode 
and applies changes 
made in Sheet 
Navigator to the actual 
sheet files.
Cancel Changes & 
Exit Renumbering… 
Exits Renumbering 
Mode without making 
any changes to sheets.
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Renumbering Mode Multi Sheet Edit
The Multi Sheet Edit tab works similar to the Sheet 
Edit tab but requires that the check box for the 
desired fields be selected.
Any changes made are applied to all sheets that are 
currently selected on the Navigator Tab.
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Notes About Renumbering Mode
Once applied changes are made in the sheet 
files.  The user must have write access to all 
effected files.
More than one change can be made in a 
renumbering session.  For example, sheets 
can be renumbered and the Sheet 
Description can be modified at the same 
time.
Make sure that the XML index is current.
A new XML index is created when 
Renumbering changes are applied.
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Settings Menu
Sheet Border 
Definitions…Opens 
the Border Definitions 
dialog box.
The Border Definitions 
dialog has three tabs, 
FDOT, Site, and 
Project.  The FDOT tab 
displays the symbology
which defines a 
standard FDOT sheet 
border.  This 
information cannot be 
modified.
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Border Definitions
The Site and Project tabs 
are used to define the 
symbology used for non 
FDOT sheet borders so that 
they will be recognized by 
the Sheet Navigator tools.
Selecting the Add New –
Select Existing Sheet 
Border button, then 
identifying the border shape 
will fill in the required 
information.  The 
symbology may also be 
manually keyed in.
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Notes on Border Definitions

Border Definitions on the Site tab will be 
searched for on all projects.  This tab is for 
use when the same non FDOT border is used 
on multiple projects.
The Project Border Definitions apply only to 
the current project.  An example of when 
project definitions would be used is in the 
case of when work is being done for a County 
that has their own sheets, or when using 
sheet from a utility company. 
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Other Notable Enhancements

Text placed from GEOPAK Plan & Profile 
Sheets is recognized by Sheet Navigator and 
will be included in the index.
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QC Software & QC Reports
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Quality Control Software
Basic Symbologies Checked

Weight
Color
Level
Text (Font/Size)
Cells
Element Types
File Types
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Quick Check

Quick Check gives the user the 
ability to do a complete quality 
assurance review on the currently 
active design file. 

When activated the program 
checks the elements in the design 
file against the selected rule file to 
find non-standard elements.

The program finds errors (non-
standard elements) and displays 
them for possible correction by the 
user.
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OverVuQC

OverVuQC assist the user in maintaining compliance to 
symbology standards on a daily bases.
OverVuQC has NO interface.
When active, OverVuQC will run Quick Check in a special "silent 
mode" whenever a design file is closed, or when MicroStation is 
exited, using the rule file specified in the QCfileList.txt.
At close/exit of the design file OverVuQC will display an OK dialog 
stating the percentage of compliance.
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Exceptions
Make Exception - When you are using Quick Check, and come upon 
an element that is not an FDOT standard and the element in question 
has been documented as being approved by the project manager, you 
can define an Exception.
A temporary addition to the standards. 
Elements matching this exception are not counted as being an error.
Allows the user to achieve the required percentage of compliance. 
These exceptions will appear in the QC Report.
At this time FDOT is allowing ten(10) exceptions for each rule file 
only.
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Creating -Exceptions

The QA/QC Report File will contain information for each 
Exception created during project development.
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Creating - Exceptions

NO EXCEPTION BUTTON ?

Resymbol – Edit > Preferences

From Category select -
Exception Rules and set 
Mode: Default
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Creating -Exceptions

From QuikChek select the 
Make Exception button.

Name the Exception –
(Must be 12 Characters 
minimum)

Describe the Exception –
(Must be 25 Characters 
minimum)
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Creating -Exceptions

A new Exception file is created with 
name of attached rule file with extension 
“.xcp” (i.e. rweng02.xcp).

Should be placed in \eng_data sub-
directory of the directory design file is in 

Turn it in with your project delivery.

New category created 
listing Exceptions.
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QA/QC Reports

FDOT CADD Production Criteria Handbook -

Each design file shall meet the threshold of compliance as 
defined in the producers’ approved CADD quality control plan, or
have a written variance from the FDOT project manager and 
documentation included in the project Journal.

This report file is a critical indicator of the quality of the 
symbology found in the MicroStation files, which will affect 
downstream use of the data and archiving processes.

The compliance report also documents whether or not the 
proper procedures and standards are being met, and shall be 
submitted as part of the electronic deliverables.

Get Over It!
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Why do I have to do QA/QC Reports ?

FDOT CADD Manual -

3.8.6 QC Reports - Compliance reports shall be produced in 
accordance with the FDOT CADD Production Criteria Handbook 
and will be delivered with the project.



36

QC Reporter – The easy way!

QC Reporter was created to provide quicker access and the 
need to run Resymbol to create QA/QC Report.
QC Reporter has three functions:

1. The production of QC Reports
2. The production of Exception Reports
3. Access to the .ini file which controls some of the functions of the 

QA/QC tool set, including RESYMBOL.



37

QA/QC Report Preferences

Set where QC report is created/saved
Set QC editor to be used
Select “List File” containing DGN filenames to process

Set “Edited Since” date to report only files after this date
Set “Compliance Less”  to report only files less than percentage

Set “Proportion Added” to assure files are being checked when data is added
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QA/QC Report ?
Exception Report ?

What are the differences…
QA/QC Report – Reports ALL selected files regardless of 
preferences
Exception Report – reports only non-compliant files of the 
selected file set according to preferences set for …
Since Date, Compliance %, Proportion Added, 
Proofreading and Snap Check  
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QA/QC Reports

All electronic deliverables require a QA/QC report for all 
MicroStation design files.
One of the QC tools, Resymbol, QA_input or Quick Check, 
had to be ran prior to running the QA/QC report.
The QA/QC reports for each discipline should be in the 
eng_data directory.

REMEMBER !!
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Electronic Delivery Interface

Browser pane
This pane shows 

documentation and 
help (HTML 

format)

Phase

Quick Launch menu

Navigation & 
Print

Documentation

Launch 
Application

Menu pane
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Electronic Delivery Journaling
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Journaling

The Journaling program provides a means to enter 
and store information about the methods and other 
information used to develop the project. The Journal 
is a diary. Project journaling is required by the FDOT 
CADD Manual.  The program also provides such 
features as

standardized insertable text
customizable insertable text
pick lists
automatic date stamping
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The Journal Interface

The Journal application edits Rich Text format files (*.RTF).

Composition Pane

Journal History Pane

Custom Text Pane

Click to 
start a 
new 
entry

Who is 
making 

the 
entry?

The 
Journal 
being 
edited
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Opening an existing Journal file

On the File 
menu, click 
Open – or – click 
the Open button   
on the toolbar. 

Journal entries 
are Rich text 
Format files.

Seed journal 
entries are 
usually found in 
each discipline 
directory.
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A completed Journal entry ready to be 
saved

Browsing 
for file 

references

Free-
form 
text 

input

Save 
Entry
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The results of saving an entry

Save the 
entry
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Using pre-defined custom text scripts
First, Begin 
New Entry

Next, highlight text 
category and press 

insert text
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The custom text script is running…

Prompt and 
data field

Navigation 
buttons
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After all prompts are completed and 
Finished…

The resulting custom 
text.  Do not forget to 
press the save button 
(or File > Save from 

the menu)
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Creating your own Custom Text scripts

Start here

Click Custom 
Text, and then 
Create
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Define the Custom Text Category, and 
create Items and option Default entries

Under Category, type 
the Name of the 
Custom Text Field 

Type the Name of the 
first item

Click Next. Continue 
this process until you 
have name all the 
necessary Items

Tip:  Click Back or 
Next to move through 
the boxes

Item title and 
default value

Custom text 
Category

Back and Next moves 
between items

When all Items are 
done, press Finish
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Save the Custom Text Script

Press 
Save

Here’s 
our new 

script

When prompted, 
answer Yes to save

Custom text scripts save time and standardize input on repetitive journaling tasks
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Electronic Delivery Indexer (EDI)
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Launch  the Indexer from the Electronic 
Delivery Interface
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Opening a project…
•Navigate to the 
project directory with 
File >Open Project.

•Indexer will scan the 
project directory each 
time it is opened

•Set the Indexer to 
“Update” mode (allows 
data to be edited)
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Creating Attribute data for files in your 
Pro

Attribute data is “metadata” or documentation about the files in your project.  
Attribute files are .XML files that contain the attribute data, one attribute file for 
each file in the project.  The SheetInfo program is used to mine .DGN files for 
sheet data.  Maintain the attribute files while you are adding data to the project.



57

Creating the Index (ProjectIndex.XML)

Once the Attribute files have been created, you can create the index 
(ProjectIndex.XML) as shown above.  ProjectIndex.XML contains special data 
about plan sheets, and should be given special attention.
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Web view of ProjectIndex.XML

This screenshot is ProjectIndex.XML with a “style sheet” applied.  Looks pretty, but 
looks can be deceiving.  You need to edit the index to make sure everything is OK.
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Opening the Index editor

The index editor gets to the basic information contained in the index with 
respect to sheets.  You should always edit the index manually to check for 
missing sheets, erroneous information, etc.
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The Index editor…It is a spreadsheet…

Sort by sheet number (Sheet Sort), then check everything in the spreadsheet

Index data can be edited, added, or deleted in edit fields shown.
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Adding Additional documentation about 
files – EDMS / Comments

Right-click on a file name to add “EDMS/Comment” data about files.

This is additional documentation you add manually. 
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The EDMS / Comment editor

EDMS data comes from pull-down list to add document Group and Type to files

General comments are “free-form,”  describe files sufficiently for end-users.
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Results of editing EDMS / Comments
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Create a Index report of all files in the 
project…
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Why all this indexing?

The indexes will be used later for several processes
The index referred to image files in the “Output File 
Specification” column while in Edit mode, and some 
said “missing”?

The Indexer predicts the names of the output that FDOT 
Batch Plotter will use for the sheet files.  This is what is 
referred to as EDI compliant naming.

After you Batch Plot (next segment) you should re-
open the indexer in Edit mode to see If EDI sees all 
of the output files (none are “missing”).
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Reminders…

Create Attribute files as you create the files you will Index (don’t 
wait until the end).
Attribute files may be created individually for selected files or in 
smaller groups by selecting groups of files or directories.
Document EDMS / Comments as you create the Attribute files
Create and maintain the index. Use the Index editor frequently. 
Watch for problems with sheet errors in your design files
If you discover EDI is having problems getting sheet Index data,
go back to MicroStation and use SheetInfo and SheetNavigator
to find and fix the problems.
Follow CADD Standards, use the resources and tools provided…
Follow FDOT CADD Standards
Follow FDOT CADD Standards



67

MS Batch Plotting
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MSBP Layout

Working 
Directory

Available
Files

Output Display view
(Results will be shown here)

Files to be plotted

Configure 
Output

Submit 
Plots

Exit 
Program
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MSBP - Fast Facts

MS Batch Plot (MSBP) uses MicroStation 
plotting to produce hardcopy and Image files 
(PostScript)
Integrated with Electronic Delivery Indexer
EDI Indexing compliant proper PostScript 
naming. (Remember the Indexer?)
Produces PostScript images, 11”x17”, and 
24”x36” plots.
Settings can saved (in .MBP files) for easy 
re-plotting
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EDI Integration 

MSBP is part of the FDOT’s 
Electronic Delivery software. To 
access the program  expand the 
“Production Phase”, expand 
”Creating Postscript Files”
and then click on the Launch icon.

Note

You can create a shortcut directly to MSBP. 
The program is located in the 
FDOT2002\win32\MSBP\ directory.
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EDI Integration

SheetInfo, MSBP and EDI (Electronic Delivery 
Index) work together to tie the delivery 
together. 

SheetInfo labels the sheets and tags the label information 
to the borders
MSBP scans the file, embeds the discipline and sheet 
number into the PostScript file name
EDI associates the DGN with its PostScript file 
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Postscript  Naming

Discipline Code is based on component order 
defined in the FDOT Plans Preparation Manual.
Sheet Number comes from Adhoc Attributes
Sheet file name with PS extension.

0001 – Roadway Plans

0002 – Signing and 
Pavement marking Plans

0003 – Signalization 
Plans, etc.

Sheet 1 shown here.  Supports 
suffixes like 1A, 23C, etc.

From the source design file
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MSBP Process (New Job)

1. Start MSBP
2. Browse to working directory
3. Create MBP file (File > New)  [MBP file saves your 

settings for the next time you run MSBP]

4. Configure MSBP if necessary (Search Criteria)

5. Define printer setup
6. Process / Print
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Executing the Program

Navigate to your project directory
Create a New project with File>New

This creates an .MBP for this session
Select the files to process
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MBP File

This file stores the settings defined in 

•Setting defined on the Printer Setup dialog
•Working directory, 
•List of files to be processed

This allows users to save the settings 
for a group of files and quickly 
reproduce the plots in the future
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Navigate to Designs directory

Click on either the Local or Network button to activate the Browse window.
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Create a New MSBP Project
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Select Files

Right click, 
double click or 
drag and drop 
files
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Search Criteria

Element Attributes
Search Files
Design View

Search Criteria defines criteria required to define 
plot area and inherited attributes.

To define search criteria select 
options from the Search menu.
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Plotting Element

To access this dialog select Search > Element from the menu

MSBP searches a design file for an element of selected 
symbology and prints everything within the limits of the 
element
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Searched Files

To access this dialog select Search > Files from the menu

By default MSBP searches only the master file, but it can be 
configured to search references for the plotting border.
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Design View

The “View Attributes” of a 
selected view can be applied 
to the output
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Printer Setup

Network, Local or LPT output (Printer tab)

Print Driver type (Config Files tab)

Design Units – Metric, English or User 
defined (Config Files tab)

Enable Raster Plotting (Raster tab)

Other settings
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Printer Selection

You can choose one of four options:

Local Printer connected directly to your 
computer

Any network printers defined on your 
workstation or browse for network printer

A LPT port mapped to a network printer
Create a PostScript image file
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Printer Selection

To access this menu click on the Printer Setup button
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Configuration Files

There are four plot driver configurations:
1. Postscript - suitable for Postscript capable printers 

such as the Xerox N series, HP PostScript printers.
2. HPGL - suitable for the HP LaserJet series (w/ HPGL)
3. PCL5 - works with PCL capable printers.
4. System Printer - the Windows system printer driver 

can be designated. 
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Configuration Files

To access this menu click on the Printer Setup button
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Raster Files

To access this menu click on the Printer Setup button
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Line Weight Adjustments
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The Process or Print Button

Process 
button when 
creating 
image files.

Print button 
when 
submitting 
to a printer.
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The results
11”x17” plots are submitted to your local or network 
printer
Electronic Postscript files are directed to the 
\Eng_data\ sub-directory beneath the discipline 
directory with the DGN file being plotted
A log of the results is displayed in the window on the 
main dialog.
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Accessing the Results

Right-Click on file to see context menu shown above



93

Example PostScript File
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Don’t Forget to Review in the Indexer!

After you have completed your batch plotting, 
re-open the Indexer (EDI) in Edit mode to 
make sure it sees all of your sheet files.
With the Index Editor, you can add sheets to 
the Index that you didn’t plot with MS Batch 
Plot, but you must browse to these manually.
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PEDDS
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Professional’s Electronic Data Delivery 
System (PEDDS)

PEDDS is used to Secure Project Data, and 
Sign & Seal files selected by a Signatory.
PEDDS uses the Fed’s SHA-1 algorithm, to 
compute a Hash code (think of fingerprint) for 
each file selected.
The Hash codes can be printed on paper, 
when added a manual signature (and seal) 
constitutes an “electronic signature” which 
meets both Florida Statutes and Board rules.
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SHA-1

SHA-1

SHA-1

SHA-1 HASH CODE 1

HASH CODE 3

HASH CODE 2

HASH CODE 4

File 
2

File 
1

File 
3

File 
4

MANIFEST File

URL / HASH 1

URL / HASH 2 …

A Manifest is a listing…A Signature file is also a Manifest
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MANIFEST or 
SIGNATURE FILE

URL / HASH 1

URL / HASH 2 …

SHA-1

MANIFEST 
DOCUMENT

HASH CODE of 
MANIFEST FILE

SIGN HERE

SIGNATURE 
DOCUMENT

HASH CODE of 
SIGNATURE FILE

SIGN / SEAL
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Creating a PEDDS Project (If it has not 
been done before)

PEDDS recognizes a project by looking for a 
\_meta_info\ directory beneath the project 
directory.  If the files ProjectID.XML if found in 
the \_meta_info\ directory, the PEDDS will see 
the project.  If not, then you must run Project > 
New from the menu pull-down to create the 
project for PEDDS.

HINT:  Use the Help in PEDDS !  Explains how to do most things (almost).
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Creating the Project and project 
Identification Information

The briefcase icons above 
indicate existing PEDDS projects

As shown, were about to “create” the 
PEDDS project for “2100041” Next, we need to create Project 

identification information (the 
ProjectID.XML file).
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Project Identification and Location

It is very important that this information be entered as accurately as possible.

On the Location screen, some field are multi-entry, combination fields (Segment and 
State Road Number).  To use these, Fill the data entries in the field(s), then press the 
Add button.  You can afterward enter another set of values and then press Add.

Don’t Forget Help!
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More Project Identification data

The State Road number is also a multi-entry, combination field.  On the 
Disciplines dialog, check the options that are anticipated to be part of the data on 
this project.

Note: the data in ProjectID can be updated later as the project progresses.
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More Project Identification data

The entire Bridge Identification dialog is a multi-entry, combination fields.

The Key Words are used for the future when people are searching for this project 
using ad-hock searches.  The General Description and Comments can be used
as search keys too.  Be verbose and describe carefully.
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More Project Identification Data

Enter the FDOT project manager and anticipated professional’s of record and 
their area of responsibility.  Again, note the multi-entry, combination fields.  
Remember, the Project ID data can but updated at and time before the project is 
secured in the end.

The project ID data is finished and the right dialog appears.  Pressing “next”…
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Additional description information

Note the Project manager dialog above.  This is used to enter the identy of the 
person managing the data for the delivery (not the Project Manager).

The Description is explained on the dialog… 
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The Main PEDDS Dialog – Let’s create a Signatory (one 
who Signs, or Signs and Seals)
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Enter the Name, Signatory Number and 
check the Signatory Type

Signatory files can be secured with a Pass-phrase, although in most cases it is not 
necessary to do so.  Security is still vested with the ink Signature and Seal !

You can create multiple Signatories for a single individual (see Scope of Work)

Create “lay” signatories (Signature – No Seal) to sign only.  Use FL Drivers 
license (which is your Official State ID by Statute) as the Signatory Number
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Select files to Sign / Sign and Seal

Choose files with Ctrl-click, or Shift-click just like in 
Windows.

Once highlighted, right-click to access function menu 
above.  Select the group with the option show.  Files 
may be selected across project directories too.
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Files selected, ready to Sign / Seal
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Sign / Seal selected files…
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The Signature Document

The Signature Document should printed, Signed / Sealed by the Signatory.  This 
document secures the files selected, and bears the SHA-1 Hash code of the 
Signatory file (which stores the listing of the files secured and their SHA-1 Hashes.

Note: Data cannot be later authenticated without a copy of the Signature 
Document.  The security is still the ink signature and impression seal !
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The aftermath of Signing / Sealing
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Create or Select additional Signatories

The active Signatory is selected from the pull-down list shown above
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Secure the Project when you are finished

Securing the project runs all files in 
the project through SHA-1.  This 
process creates the Manifest file -
(Manifest.XML)

Note:  Securing the 
project is normally 
done near the end –
This slide was placed 
here for continuity
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The Manifest Document

The Manifest Document bears the Hash codes for the Manifest File
(Manifest.XML) which secures the entire project.  Print and sign too !

Note: Projects may be re-secured at any time, even if there are no Signatories
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Project Browser
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ProjectBrowser is a general purpose 
browsing tool, but does more…

Validates that Signed / Sealed, Indexed, and on-disk 
files are present and accounted for
Creates the browser viewable index:

Creates Sheetndx.htm – the index viewable with an internet 
browser and forwarded to the letting

Creates a Composite Plans Set 
Creates a Composite (multi-page) PostScript file called 
Project.PS in the root Project Directory encapsulating the 
plan sheet image files into a single, ordered document.
Now creates the composite .PDF of Plans set 
(Project.PDF)
Handles more indexed sheet file formats, including TIF and 
JPG files of plans sheets (including existing .PDF – as long 
as the source .PDF contains no encryption).
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Project Browser – Creating Composite 
PDF file

Project browser has been modified to create 
a composite PDF of Plans – how it works:

Uses the Index (ProjectIndex.xml)
Uses the Image files of the indexed plans sheets

PostScript, Non-encrypted Acrobat PDF, JPG, TIF, etc.
Before concatenation, all formats converted to PS

PDF PS using GhostScript
BMP, TIF, etc. JPG PS using new internal utilities

Concatenation done as composite PS
Composite PS PDF using GhostScript
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Project Browser – Creating Composite 
PDF file

Not a “perfect” solution
No control over original:

Size (output sheet dimensions same as originals)
Rotation (be careful of non- MS Batchplot created PostScript)
Pixel density (resolution) Cannot make a $1 out of 35¢

Preserves what is there in the data source
Be conscience of the target paper sizes (Tabloid & Ledger)
No control of page numbering in the final PDF

Orientation, page size can be issues depending on data 
sources

Still a need for Acrobat to clean up Project.PDF – just far 
less clean-up required
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Open a Project Index (ProjectIndex.XML)
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The Project Browser validates data

The Project Index File (ProjectIndex.XML) is validated against the files actually on-disk.  Also, The PEDDS 
Signature files are validated against the files on-disk.  What is being checked is that the files are present.

Note: Unless all files are present and accounted for, Project Browser will not continue
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The Tree View The Tree view is 
accessible from the 
button to the left of 
the Print Button.  
This view displays 
project data by 
component.  You 
expand [+] and 
contract [-] nodes 
just like with other 
Windows tree 
controls.  The blue 
text are hyperlinks
and will launch the 
file shown with the 
associated 
application.  An Icon 
legend is shown, 
that may be evoked 
with the keys button.

Detailed Project ID 
information and all 
the project-wide 
Journals are also 
accessible.
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Grid view of the Index Data
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Enhanced HTML creation
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Sheetndx.HTM file creation (required)
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Creating Project.PS and Project.PDF

Required

Project.pdf

Be patient, these processes take time on large projects
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What’s next?

When all the files for the project have been 
created and checked, return to PEDDS:

Signatories should Sign / Seal any remaining files
A signatory should sign** ProjectIndex.XML, 
Sheetndx.HTM, and Project.PDF

Authenticate each signatory to ensure no file 
previously signed / sealed has been modified or 
deleted
Secure the entire project.  This data set is know 
as the Project data set, and should be written to 
the “Project CD”.  Label that CD per the CPCH.

**Some districts are requiring signature and seal for some of these files
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Now we need to make the data set for 
advertisement and letting…

The data that will be advertised for contract and 
letting is an sub-set of the Project data set
The project data set must be secured in PEDDS and 
must be able to Authenticate before the sub-set can 
be created
The sub-set is called the “Plans and Specs” data set
The Plans and Specs data set is only the signed 
and sealed plans sheets, specs, and the 
ProjectIndex.XML, Sheetndx.HTM, and Project.PDF
A tool called “SetMaker” helps build this
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SetMaker
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How does SetMaker work

New application on the interface called “SetMaker”
Designed to help make a sub-set of the project suitable for 
electronic advertisement (Plans and Specs)
Automated file selection by

Signed and Sealed
Secured
presence in Indexes(ProjectIndex.XML and/or Sheetnxd.htm)
Plans Component (Roadway, Signalization, etc.)
Custom rules (inclusion /exclusion by directory and wildcard)

Selected files get copied to new location, are automatically 
Secured (without needing to return to PEDDS) and burned 
to CR-ROM
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Open a Project in SetMaker
Turn on PEDDS File Validation 
– this will cause SetMaker to 
cross-validate Manifest and 
Signatory files with on-disk 
files (full Authentication)

SetMaker will always validate 
indexes against on-disk files

Validation is very important so 
sub-sets created from 
SetMaker are perfect sub-sets

Open the project with 
the ellipsis button
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SetMaker Interface
Files are displayed in a 
tree control with selector 
boxes which can be used 
to manually select files to 
be included in the sub-set
If a file is highlighted, file 
properties are displayed in 
the left-hand pane
An Icon legend is available 
under the view menu
An error report is also 
available under the view 
menu (if errors were 
detected when opening the 
project) 
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What about errors in the source folder?
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Choose files automatically

Files may be selected 
automatically using file selection 
rules.  In the group section, the 
setting typically used to make the 
Plans & Specs dataset are shown.

Other rules may be chosen as 
needed, and folder rules that 
support wildcard selection or 
exclusion may be selected.

Select the Apply button once the 
rules are decided upon

Select the file rules, then press the apply button and the files will automatically be 
checked 
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Automatic File Selection

Select the file rules, then press the apply button and the files will automatically be 
checked 
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Adding Custom Rules

Custom rules are selected 
by folder, and can be set 
to Include or Exclude files 
by filename / extension 
pattern

Right-click
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Saving Selection Rules

Selection Rules can be opened in 
other projects, and used to select the 
files for the next set to be created.
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Saving the Selection Set

The selection set are 
those specific files 
selected for the subset.

The selection set is project 
/ environment specific as it 
contains local file-path 
information for each file.
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Set the destination directory for the subset

The destination folder for the sub-set is set by 
pressing the ellipsis button to browse a folder, and/or 
may be keyed-in.
You can edit the Destination Folder field to make 
corrections, add additional path, etc.
Press the Create Set button (or select File > Create 
Set from the Menu)
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Creating the Set

Press the Create Set Button, or select Create Set 
from the File menu:

The selected files are copied to the destination folder 
(directories without selected files and empty directories are 
not copied)
If Signed/Sealed rule is selected, Signatories will not be 
broken (to ensure all signatories can be authenticated in 
the sub-set).  This means ALL files secured by ALL 
Signatories will be copied.
Once the sub-set has been created, SetMaker 
automatically Secures the new set (Like PEDDS does) and 
creates a Manifest report for the new set.



141

User information is entered for the reason 
for the sub-set

This data becomes part of the 
Manifest file.  SetMaker automatically 
secures the project after creating the 
sub-set

Print the Manifest report and sign-it



142

Now what?

The Original project directory data represents the 
data that should be burned onto the “Project” CD-
ROM.
The sub-set just created should be burned onto the 
“Plans and Specs” CD-ROM
Sometimes it takes more than one CD-ROM or 
DVD-ROM to hold a large project.  In that case split 
it between multiples (make sure the label reads “1 of 
…”, “2 of …”
All CD-ROM labels should also  include the 
expected letting date (as of 5/19/2004) in addition to 
the label requirement in the CPCH


